
P O G L A V L J E  J E D A N

Početak

Pre nekoliko godina firma Adobe Systems predstavila je PDF (Porta-
ble Document Format) kao nov format dokumenata. Bio je to revo-
lucionaran potez – dokument koji čitalac vidi na ekranu verna je 
kopija onoga što se pojavljuje u štampi. Više nije neophodno da 
usklađujete dizajn i izgled stranice s mogućnostima računara koji 
će otvoriti i prikazati dokument. 

Adobe neprekidno razvija PDF format i programski paket Acrobat. 
Od skromnog početka 1992. godine do danas, Acrobat je doživeo neko-
liko verzija. Poslednji izdanak ove porodice programa nosi oznaku 
Acrobat 6. Pošto čitate ovu knjigu, znači da ste ponosni vlasnik pro-
grama Acrobat 6 Standard. Acrobat 6 obuhvata i verzije Professional 
i Elements, koje nude različite mogućnosti i funkcionalnost.

Dok učite da koristite program, postajete svesni dve važne 
činjenice:

• Ništa nije „standardno“ kada je reč o programu Acrobat 
Standard.

• Prikazivanje PDF datoteka samo je deo onoga što Acrobat 
pruža.

U ovom poglavlju upoznaćete komponente programa i naučićete 
kako da postignete da korisničko okruženje radi za vas. Podrazume-
vano radno okruženje obuhvata nekoliko paleta sa alatkama i opci-
jama, ali nije neophodno da sve bude na ekranu u isto vreme.
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SAVET 

1  Mesto za sve
Kada prvi put pokrenete Acrobat 6 Standard, pojaviće se okruženje 
prikazano na slici 1.1 (naravno, bez slike ruže). Na ekranu ćete 
videti sledeće komponente:

Slika 1.1 Korisničko okruženje Acrobata 6 ima nekoliko oblasti.

• Osnovni meni. Stavke osnovnog menija poređane su pri vrhu 
prozora (slika 1.2). Sa stavkama File, Edit, View, Window i 
Help već ste se upoznali. Ostali elementi osnovnog menija, 
poput Document, Tools i Advanced, sadrže opcije koje su speci-
fične za Acrobat.

Slika 1.2 Pojedine stavke osnovnog menija nalaze se i u drugim  
programima.

Linija menija Palete alatki Okno How To

Prozor dokumenta Statusna traka Pomoć
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• Palete alatki. Acrobat 6 ima mnogo paleta alatki. Osnovni 
raspored paleta prikazan je na slici 1.3. Mnoge opcije na pale-
tama alatki na raspolaganju su i kao komande iz menija. Stre-
lica na desnoj strani usmerena nadole ukazuje na postojanje 
skrivene palete alatki. Pritisnite strelicu da biste prikazali skri-
vene opcije.

Slika 1.3 Osnovna paleta alatki i paleta poslova programa sastoje se od 
nekoliko komponenata.

• Okno Navigation. Duž leve strane prozora videćete skup ver-
tikalno poređanih kartica. Ove kartice čine okno Navigation 
(slika 1.4), a opcije u njima omogućavaju vam da na različite 
načine upravljate PDF dokumentima i kontrolišete njihov sadr-
žaj. Na slici je prikazan podrazumevan skup kartica.

 
Slika 1.4 Okno Navigation nalazi se 
na levoj strani prozora programa.

• Prozor dokumenta. Otvoreni dokumenti prikazuju se u pro-
zoru dokumenta (slika 1.5). Ispod otvorenog dokumenta, 
Acrobat prikazuje veličinu stranice. Vertikalna i horizontalna 
klizna traka dozvoljavaju premeštanje vidljivog dela doku-
menta prema potrebi.

Pogledajte pre nego što 
dodirnete
Izgled korisničkog okruženja 
možete da promenite tako što 
ćete premestiti ili zatvoriti pale-
te alatki, kartice okna Naviga-
tion itd. Pre nego što to učinite, 
upoznajte se sa njihovim sadr-
žajem. Primera radi, pritisnite 
padajuće menije da biste videli 
skrivene alatke ili opcije. Pri-
tisnite jezičak kartice u oknu 
Navigation i pogledajte koje su 
opcije dostupne. Analiziranje 
osnovne postavke Acrobata mo-
že vam pomoći dok učite kako 
se radi u ovom programu.

SAVET 1: Mesto za sve
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Slika 1.5 Koristite prozor 
dokumenta da biste  
kontrolisali svoju poziciju  
u dokumentu.

• Statusna traka. Statusna traka se nalazi ispod prozora doku-
menta (slika 1.6). Na njoj se vide redni broj tekuće strane, 
ukupan broj strana i način prikaza dokumenta. Odgovarajuća 
ikonica označava da li su prikazane pojedinačne strane ili 
neprekidan niz strana. Koristite komande za kretanje da biste 
se pomerali unazad ili unapred po dokumentu.

Slika 1.6 Statusna traka pokazuje broj tekuće strane, ukupan broj stra-
na i način prikazivanja stranica u dokumentu.

• Kako da... Okno How To (slika 1.7) nalazi se na desnoj strani 
ekrana i prikazuje nekoliko veza ka uputstvima za uobičajene 
poslove koji mogu da se obave u Acrobatu. Ovo okno je odvo-
jeno od sistema za pomoć i koristi se za brži pristup uput-
stvima. Oknu ne možete da promenite veličinu, ali možete da 
ga sakrijete.

 
Slika 1.7 Koristite okno How To za 
brzu pomoć u radu s programom.
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SAVET 

2  Prva pomoć
Okno How To sadrži listu uobičajenih poslova koje ćete najčešće oba-
vljati pomoću Acrobata (slika 1.8). Pridržavajte se sledećih saveta 
da biste pomoću okna How To došli do uputstava za rad s progra-
mom:

 

Slika 1.8 Izaberite neku od 
glavnih tema da bi se prikazao 
spisak tema u oknu How To.

• Spisak glavnih tema pojavljuje se u oknu How To (slika 1.9). 
Koristite klizne trake da biste pristupili kompletnom spisku. 
Pritiskom na hipervezu ka nazivu određenog posla, uspećete 
da pristupite odgovarajućem uputstvu.

 

Slika 1.9 Svaki izabrani posao 
sadrži i spisak tema koje se na 
njega odnose.

• Uputstvo za izvršavanje posla ili zadatka pojavljuje se u oknu 
How To (slika 1.10). Pomerajte prikaz u oknu liste da biste 
pročitali čitavo uputstvo.

 

Slika 1.10 Pročitajte uputstvo 
ako ne znate kako da dovršite 
započeti posao.

SAVET 2: Prva pomoć

Kako da... ili ne
Neki korisnici se osećaju sa-
svim prijatno kada je ekran 
preplavljen menijima i okvirima 
za dijalog; drugi prednost daju 
što većem radnom prostoru. U 
podrazumevanom stanju, Acro-
bat nakon učitavanja prikazuje 
okno How To. Ovo okno možete 
sakriti i koristiti druge opcije da 
biste, kad vam to zatreba, pri-
stupili uputstvima za rad 
s programom:

• Pritisnite dugme Hide i zatvori-
te okno ako za posao koristite 
opcije koje dobro poznajete. 

• U podrazumevanoj postavci 
paleta sa alatkama, pritisnite 
dugme How To kako biste po-
novo otvorili okno. Okno će 
se pojaviti na istom mestu 
na ekranu.

• Neka okno How To bude otvo-
reno sve dok ne upoznate op-
cije Acrobata i naviknete se 
na rad u ovom programu. Ako 
smatrate da posao možete 
obaviti i bez uputstava, poni-
štite izbor opcije Show How 
To Window at Startup u oknu 
How To. Od tog trenutka, 
okno How To neće se prikazi-
vati kada pokrenete program, 
ali ga možete otvoriti ukoliko 
vam zatreba.
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• Pri kraju uputstva za neki posao, pronaći ćete dodatne hiper-
veze (slika 1.11). Upotrebite ove veze da biste pronašli više 
podataka o sličnim poslovima, i hiperveze ka glavnom meniju 
Help.

 

Slika 1.11 I dalje ne znate kako da  
nešto uradite? Za dodatne podatke 
sledite hipervezu ili upotrebite glavni 
sistem za pomoć.

• Koristite tastere za kretanje na vrhu okna How To, da biste oda-
brali odgovarajući prikaz (slika 1.12). Pritiskanjem aktivne 
strelice (ikonice aktivnih strelica obojene su plavom bojom), 
kretaćete se između stranica koje ste pregledali; pritisnite 
taster miša da biste se vratili na glavnu stranicu okna How To.

Slika 1.12 Poziciju u dokumentu možete kontrolisati  
pomoću dugmadi za kretanje u oknu How To.

Kako da...
Ukoliko promenite raspored 
paleta alatki, verovatno ćete 
zatvoriti okno How To. Da biste 
pristupili njegovom sadržaju, 
upotrebite meni Help. Izaberite 
komandu Help > How To Win-
dow i potom izaberite jednu 
opciju sa liste. 
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SAVET 

3  Upotreba menija Help
Okno How To pruža uputstva „korak po korak“ za rad sa osnovnim 
funkcijama i opcijama programa. Ukoliko su vam potrebni detaljniji 
podaci, koristite glavni sistem za pomoć:

1. Izaberite opciju Help > Complete Acrobat 6.0 Help (slika 
1.13). Sistem za pomoć u vidu zasebnog programa otvoriće se 
u sopstvenom prozoru.

  

Slika 1.13 Celovit sistem za pomoć 
Acrobat 6 Help otvara se u zasebnom 
prozoru.

2. Koristite komande za kretanje po sistemu za pomoć koje se 
nalaze u vrhu leve strane prozora (slika 1.14). Plave strelice 
vam omogućavaju kretanje po stranama na kojima ste već bili. 
Pritisnite ikonicu štampača da biste odštampali temu koja je pri-
kazana u osnovnom oknu prozora Help. Ikonice plus (+) i minus 
(-) omogućavaju vam da povećate ili da smanjite prikaz.

 
Slika 1.14 Koristite odgovarajuće ko-
mande za kretanje po sistemu za pomoć.

3. Odaberite jedan od tri modela ponuđenih opcija za pretraži-
vanje – Contents, Search ili Index – zavisno od toga šta tražite 
i kako ste navikli da radite:

• Kada otvorite meni Help u njemu se vidi sadržaj kartice Con-
tents (slika 1.15). Svaki znak plus (+) pored imena teme 
označava postojanje podteme. Pritiskom na + otvara se 
lista ugnežđenih stavki. Ukoliko je uz ime teme minus (-), 
to znači da je ugnežđeni sadržaj već prikazan. Pritisnite 
stavku da bi se njen sadržaj prikazao u osnovnom oknu pro-
zora Help.

SAVET 3: Upotreba menija Help
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Slika 1.15 Određene teme su grupisane 
unutar većih tema na levoj strani okna.

• Pritisnite jezičak kartice Search da biste prikazali njen sadr-
žaj. Unesite reč koju tražite i pritisnite dugme Search. Teme 
koje sadrže traženu reč ili pojam prikazaće se u levom oknu 
prozora Help (slika 1.16). Pritisnite naziv teme na listi u 
levom oknu da bi se njen sadržaj prikazao u glavnom oknu; 
Acrobat će istaći svako pojavljivanje traženog pojma.

Slika 1.16 Koristite mogućnosti opcije Search da biste pronašli  
odgovarajući pojam u sistemu za pomoć.

Napomena
Ukoliko vam istaknuti pojmovi odvlače pažnju, alatkom Hand pritisnite 
bilo koje mesto na stranici i tako uklonite isticanje reči.

Pomoć oko pomoći
Obratite pažnju na to kako radi-
te u Acrobatu. Ukoliko ste siste-
matični u radu, koristite karticu 
Contents prozora Help jer ćete 
tako lakše pristupati temama, 
od opštih do specijalizovanih. 
Ukoliko dobro poznajete Acro-
bat i znate koje podatke tražite, 
koristite opciju Search. Ako 
niste sigurni koju temu tražite, 
ali načelno imate ideju, pokušaj-
te sa opcijom Index. Ponekad je 
dovoljno da vidite samo deo na-
slova da biste shvatili da upra-
vo to tražite.
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 • Izaberite jezičak kartice Index, a potom iz menija Show iza-
berite opciju All da biste prikazali spisak tema po abeced-
nom redu (slika 1.17). Izaberite početno slovo reči koju 
tražite u indeksu, ili ostavite aktivnu opciju All. Krećite se 
kroz listu u levom oknu prozora Help. I ovog puta sadržaj je 
prikazan u ugnežđenim temama. Pritisnite tasterom miša da 
biste otvorili temu. Ukoliko pritisnete ime teme, njen sadržaj 
unutar indeksa prikazaće se u glavnom oknu prozora Help. 

 
Slika 1.17 Teme možete pretraživati 
pomoću kartice Index.

Napomena
Za neke poslove sistem za pomoć će vam često biti potreban. Da ne biste 
stalno zatvarali prozor Help i ponovo ga otvarali tražeći pravi podatak, 
minimizirajte prozor. Njegov sadržaj će biti isti kao kada ste ga posled-
nji put prikazali, pa možete jednostavno da prelazite iz dokumenta u 
Acrobatu u prozor Help i obrnuto (slika 1.18). Takođe, možete promeniti 
veličinu oba prozora i istovremeno ih prikazati na ekranu, ali ukoliko ne 
morate da čitate baš svaku reč uputstva, minimizirajte prozor da biste 
bolje iskoristili radni prostor na ekranu.

 

Slika 1.18 Prikažite 
istovremeno prozore 
vašeg dokumenta 
i prozor sistema za 
pomoć.

SAVET 3: Upotreba menija Help
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SAVET 

4  Oslobodite prostor na ekranu
Jedan od najboljih načina da obezbedite dovoljno prostora na ekranu 
i da sačuvate vid, jeste da smanjite broj prikazanih alatki. Slika 1.19 
pokazuje kako ne treba da izgleda radni prostor. Skoro sve palete i 
dugmad za pokretanje poslova nalaze se na ekranu. Čak i u prikazu 
preko celog ekrana, ostaje veoma malo prostora za tekući dokument. 
Pored toga, potrošićete mnogo vremena pokušavajući da pronađete 
neku alatku kada vam zaista zatreba. Naredne preporuke će vam 
pomoći da umanjite zbrku na ekranu. 

Slika 1.19 Ukoliko otvorite sve palete alatki, ostaće vam malo prostora za rad.

• Čak i ako koristite samo osnovne palete alatki, možete se zbu-
niti. Postavite pokazivač iznad šrafirane vertikalne linije na levoj 
ivici palete alatki da bi se prikazalo ime palete (slika 1.20).

 
Slika 1.20 Prikazivanje imena palete 
alatki u ekranskom savetu.

• Ekranski saveti prikazuju nazive dugmadi. Ukoliko je dugme 
dovoljno veliko da se na njemu vide i ikonice i tekst, iz saveta 
nećete saznati ništa novo. Međutim, ako postavite pokazivač 
miša preko ikonice, pojaviće se ime dugmeta iz koga možete 
da zaključite koja je njegova funkcija (slika 1.21).

 
Slika 1.21 Ekranski savet prikazuje 
ime dugmeta.

Mogućnost ponovnog 
vraćanja
Ukoliko ste prikazali znatan broj 
paleta alatki a želite da se vra-
tite na podrazumevani skup, 
izaberite opciju View > Toolbars 
> Reset Toolbars. Okruženje će 
ponovo izgledati kao nakon 
prvog pokretanja programa.
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• Postavite pokazivač miša iznad šrafirane vertikalne linije i 
povucite da biste pomerili paletu alatki sa pozicije na kojoj je 
usidrena. Kada otpustite taster miša, paleta alatki će plutati 
na ekranu (slika 1.22).

 
Slika 1.22 Paleta alatki može se usidriti 
na vrhu prozora ili plutati na ekranu.

• Dugmad za pokretanje poslova radi neznatno drugačije. Ne 
možete prevući samo jedno dugme s palete poslova (što možete 
uraditi s pojedinačnim alatkama na paletama); ako to pokušate, 
premestićete čitavu paletu. Izaberite opciju View > Task But-
tons i odaberite dugmad ili poništite njihov izbor (slika 1.23).

 

Slika 1.23 Dugmad 
za pokretanje poslova 
iz menija View.

• Dok radite, često ćete menjati palete. Uštedite jedan korak 
koristeći priručne menije. Pritisnite desni taster miša ili uz pri-
tisnut taster Ctrl, mišem pritisnite traku za razdvajanje i prika-
zaće se iste opcije koje su vam na raspolaganju kada koristite 
menije palete alatki (slika 1.24). 

 

Slika 1.24 Koristite priručni meni za prika-
zivanje komandi koje su dostupne iz menija 
View.

SAVET 4: Oslobodite prostor na ekranu

Zaključavanje paleta 
alatki
Kada zatvorite pa ponovo otvo-
rite program, raspored paleta 
alatki i dugmadi za poslove osta-
je isti. Ukoliko vam odgovara 
drugačiji raspored, zaključajte 
palete. Kada Acrobat upoznate 
do te mere da se u njemu oseća-
te „kao riba u vodi“, odaberite 
alatke s kojima ćete raditi bez 
stalnog pretraživanja po paleta-
ma. Izaberite View > Toolbars 
> Lock Toolbars. Tom prilikom 
nestaće linije za razdvajanje 
između paleta. Plutajuće palete 
se ne zaključavaju i ne mogu se 
usidriti uz zaključane palete.
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SAVET 

5  Početak rada punom brzinom
U Acrobatu možete podesiti nekoliko parametara koji će vam omo-
gućiti brži rad, bilo da je reč o bržem pokretanju programa ili da se 
rezultati rada u dokumentu brže prikazuju:

1. Izaberite opciju Edit > Preferences > General. Otvoriće se okvir 
za dijalog Preferences sa podužim spiskom parametara u levom 
oknu. Izaberite stavku Startup da bi se u desnom oknu okvira za 
dijalog pojavili parametri za pokretanje programa (slika 1.25).

Slika 1.25 Pomoću parametara Startup promenite način na koji se  
program pokreće. 

2. Odeljak Opening Documents nalazi se u gornjem delu prozora. 
U padajućoj listi Reopen Documents to last Viewed page, pod-
razumevano je izabrana opcija eBooks Only, što znači da će se 
samo elektronske knjige ponovo otvoriti na onoj strani koja je 
poslednja prikazana u prozoru dokumenta.

Pritisnite strelicu padajuće liste i izaberite opciju All Files 
(slika 1.26). Ovaj parametar je veoma koristan kada mnogo 
vremena provodite radeći sa više dokumenata. Svaki put kada 
otvorite dokument, mesto u dokumentu i stranica koja je 
poslednji put prikazana pojaviće su u prozoru dokumenta.

 

Slika 1.26 Koristite opciju 
All Files kada radite sa više 
dokumenata.

Uvodni ekran
Donji odeljak parametara Star-
tup sadrži opciju za prikazivanje 
uvodnog ekrana. Nekim korisni-
cima se dopada ideja da isklju-
če prikazivanje uvodnog ekrana 
misleći da na taj način ubrza-
vaju program. To nije tačno. Ja 
više volim kada se uvodni ekran 
prikazuje bar dok se dovoljno 
ne nagledam crteža na njemu.
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Napomena
Opcija za prikaz radi na opisani način samo tokom jedne seanse u Acro-
batu 6; ukoliko zatvorite i ponovo otvorite program, a potom i dokument, 
prikaz zavisi od parametara dokumenta te će se uglavnom videti vrh prve 
strane.

3. Izaberite opciju Use Page Cache (koja podrazumevano nije 
izabrana). Ukoliko keširate strane, dok gledate jednu stranu 
dokumenta, sledeća se učitava i smešta u rezervisani prostor 
(engl. buffer area), sve dok ne odlučite da je pogledate. Tako 
se strane brže učitavaju što je posebno uočljivo dok radite sa 
interaktivnim dokumentima ili ako u njima ima mnogo slika.

4. Preostale dve opcije koje pripadaju oblasti Opening Docu-
ments, mogu da ostanu izabrane. Layer State se koristi za 
dokumente sa slojevima; autor dokumenta određuje koji će 
se slojevi prikazati kada se dokument otvori u Acrobatu. Treća 
opcija, Display the Document Status Dialog for, omogućuje da 
se prikažu dodatni podaci o objektima, kao što su slojevi i digi-
talni potpisi.

5. Izaberite stavku Page Display u levom oknu okvira za dijalog 
Preferences. Ovde možete podesiti pojedine parametre stra-
nica kako biste radili brže.

6. Acrobat podrazumevano prikazuje velike slike. Poništite izbor 
opcije Display large images (slika 1.27) ukoliko vaš računar 
sporo iscrtava sadržaj ekrana. Slika će se prikazati i na sporom 
računaru, ali treba mnogo vremena da se ona iscrta na ekranu. 
Svaki put kada upotrebite klizne trake ili na drugi način pome-
rite dokument u prozoru dokumenta, morate sačekati da se 
slika ponovo iscrta.

 

Slika 1.27 Ukoliko vaš računar 
ne može brzo da iscrtava slike, 
isključite prikazivanje velikih 
slika.

SAVET 5: Početak rada punom brzinom



POGLAVLJE JEDAN Početak

14

7. Izaberite opciju Use greek text below xx Pixels, da biste tekst 
manji od zadate veličine (podrazumevana veličina je 6 pik-
sela) prikazali kao sive linije (slika 1.28). Izborom ove opcije 
brzina iscrtavanja znatno se povećava.

 

Slika 1.28 Zamena veoma sitnog 
teksta sivim linijama ubrzava 
prikazivanje strana.

8. Kad podesite i izmenite parametre, pritisnite dugme OK da 
biste zatvorili okvir za dijalog Preferences i primenili nove 
parametre.

Parametri za sva  
vremena
Parametri koje izaberete ne 
odnose se samo na određeni 
dokument već na čitav program. 
Svaki put kada otvorite Acrobat 
6, program koristi parametre ko-
je ste definisali sve dok ih pono-
vo ne promenite.



P O G L A V L J E  D V A

Pretvaranje izvornih 
dokumenata  
u format PDF

PDF dokumente možete da pravite na više načina. U prethodnim ver-
zijama Acrobata, korisnici su pretežno izvozili PDF datoteke iz raznih 
izvornih programa ili su uvozili Web stranice i pretvarali ih u format 
PDF. Acrobat 6 omogućava da u format PDF konvertujete jednu dato-
teku ili više njih, kao i sadržaj iz Clipboarda, ne napuštajući okruže-
nje Acrobata.

Izvorne dokumente konvertujete u PDF pomoću makroa PDFMa-
ker, Acrobat Distillera ili bilo kog programa koji može neposredno da 
izveze PDF datoteke. Nezavisno od metoda konverzije, uvek morate 
da uzmete u obzir iste činioce. U ovom poglavlju naučićete kako da 
uskladite parametre konverzije s materijalom koji obrađujete. Na pri-
mer, dokumente koji su namenjeni štampanju pripremate drugačije 
od dokumenata koje ćete postaviti na Internet.

Opcije u Acrobatu 6 predstavljene su korisniku na zanimljiv 
način. Iako postoji veliki broj paleta i stavki u menijima, možete iza-
brati funkcionalan pristup, što znači da ćete birati odgovarajući skup 
alatki i opcija na osnovu prirode posla koji treba da obavite.
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SAVET 

6  
Pravljenje PDF dokumenata 
iz izvornih programa

Ako možete da štampate iz nekog programa, to je najčešće sasvim 
dovoljno da biste napravili PDF datoteku. Ključnu ulogu ima upra-
vljački program za štampač pod imenom Distiller. Ovaj upravljački 
program ne morate posebno da instalirate jer je deo instalacione 
procedure Acrobata 6. Upravljački program za štampač Distiller i 
Acrobat Distiller imaju veze jedan s drugim ali Acrobat Distiller je 
aplikacija. Da biste napravili PDF datoteku iz izvornog programa, pri-
menite sledeće korake:

1. Pokrenite izvorni program i otvorite dokument koji hoćete da 
konvertujete u PDF.

2. Izaberite opciju File > Print da biste otvorili okvir za dijalog 
Print.

3. Pritisnite padajuću listu Name i sa spiska štampača izaberite 
Adobe PDF (slika 2.1).

Slika 2.1 Upotrebite upravljački program Acrobat Distiller da biste  
pravili PDF datoteke.
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4. Pritisnite OK. Datoteka će biti obrađena i otvoriće se okvir za 
dijalog Save (slika 2.2).

Slika 2.2 Izaberite mesto gde ćete snimiti datoteku koja je pretvorena  
u format PDF.

5. Iz padajuće liste Save in izaberite lokaciju na koju ćete sni-
miti datoteku, po potrebi promenite ime datoteke i pritisnite 
dugme Save. Datoteka će se odštampati u PDF umesto na štam-
paču i dobićete PDF verziju izvorne datoteke.

U nekim programima datoteku možete odmah da snimite kao PDF. 
Evo primera u kome je korišćen program Adobe Photoshop:

1. Izaberite opciju File > Save As da biste otvorili okvir za dijalog 
Save As.

2. Pritisnite padajuću listu Format i sa spiska formata datoteka 
izaberite opciju Photoshop PDF (slika 2.3).

SAVET 6: Pravljenje PDF dokumenata iz izvornih programa

Imena datoteka i formati
Izgradite sopstveni sistem za da-
vanje imena datotekama kada 
konvertujete dokumente iz jed-
nog formata u drugi. Kada štam-
pate prema navedenim koraci-
ma, podrazumevano se otvara 
direktorijum koji sadrži izvorni 
dokument i datoteka dobija ime 
izvornog dokumenta s nastav-
kom .pdf. 
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Slika 2.3 U programima iz kojih se može direktno  
izvoziti u PDF, upotrebite komandu Save As.

3. Pritisnite dugme Save. Okvir za dijalog će se zatvoriti a Photo-
shop će snimiti i prikazati datoteku (slika 2.4).

Slika 2.4 Photoshop prikazuje sliku snimljenu  
u formatu PDF.

Nešto više o kompresiji 
slika
U zavisnosti od vrste kompre-
sije, postoje i dodatni okviri za 
dijalog za snimanje datoteka. 
Na primer, i za JPEG i za Zip 
kompresiju možete da izaberete 
opcije za interpolaciju ili pro-
menu rezolucije slike. Za JPEG 
kompresiju možete da birate 
i nivo kvaliteta. Izaberite nivo 
kvaliteta koji odgovara krajnjoj 
nameni slike. Ako planirate da 
koristite sliku na Internetu, do-
voljan je nivo kvaliteta između 
srednjeg i visokog (5 do 8 na 
skali kvaliteta). Za slike name-
njene štampi, izaberite viši nivo 
kvaliteta.
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Izbor kompresije
Odluke o opcijama za kompresiju donosite više puta: kada konvertujete datote-
ke iz izvornih dokumenata, u Distilleru i u aplikacijama paketa Microsoft Office. 
Koje će vam opcije biti na raspolaganju, zavisi od načina konverzije. Kompresiju 
koristite da biste smanjili veličinu PDF datoteka; upotrebom odgovarajućeg for-
mata smanjićete veličinu datoteke bez gubitka kvaliteta.

Kako da izaberete najbolju opciju? Evo kratkih saveta za svaku vrstu kompresije 
uz primere koji pokazuju kada da koristite koji format:

• Upotrebite Zip kompresiju za slike s velikim jednobojnim površinama ili deta-
ljima koji se ponavljaju (slika 2.5).

• Upotrebite JPEG kompresiju za slike u sivim nijansama ili u boji, kao što su 
fotografije (slika 2.6).

• Metoda kompresije CCITT pogodna je skenirane uzorke kao i za crno-bele 
slike napravljene programima za slikanje. Acrobat podržava metode kompre-
sije CCITT Group 3 i Group 4 (slika 2.7).

• Kompresija Run-length je najpogodnija za slike s velikim crnim ili belim povr-
šinama (slika 2.8).

Slika 2.5 Zip kompresija je 
najbolja za slike s detaljima 
koji se ponavljaju ili s velikim 
jednobojnim površinama.

Slika 2.8 Upotrebite kompresiju 
Run-length za slike s velikim  
crnim ili belim površinama.

Slika 2.6 Upotrebite JPEG  
kompresiju za slike u sivim  
nijansama i fotografije.

Slika 2.7 Kompresija 
CCITT je pogodna za  
ovakve slike.

SAVET 6: Pravljenje PDF dokumenata iz izvornih programa
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SAVET 

7  
Upotreba makroa 
PDFMaker u Wordu

Microsoft Word i Acrobat su stari znanci. Kada napravite Wordov 
dokument, možete da ga konvertujete u PDF i da ga potom pošaljete 
u svet. Uz Acrobat 6 i najnoviju verziju Worda, postupak konverzije 
nikada nije bio lakši.

1. Otvorite dokument koji hoćete da pretvorite u PDF. Pritisnite 
dugme Convert to Adobe PDF na paleti alatki PDFMaker 6.0 
(slika 2.9) ili izaberite opciju Adobe PDF > Convert to Adobe 
PDF (slika 2.10). Otvoriće se okvir za dijalog koji prikazuje 
napredovanje procesa konverzije.

 
Slika 2.9 Nakon instalacije Acrobata, u 
Wordu će biti dodata nova paleta alatki.

Slika 2.10 Acrobat dodaje nekoliko novih stavki menija u Word.

2. Na statusnoj traci najpre ćete videti ikonicu štampača , a 
potom i crvenu ikonicu Distillera . Dok traje konverzija, iko-
nica Distillera rotira.

3. Po završetku konverzije okvir za dijalog će se zatvoriti a iko-
nice Distillera i štampača nestaće sa statusne trake.

4. PDF datoteka će se otvoriti u Acrobatu 6 (što je podrazume-
vana opcija) ili ćete se vratiti u Officeov dokument.

Nove alatke za Office
Ako instalirate Acrobat 6 na 
računaru na kojem je instaliran 
Microsoft Office XP ili novija ver-
zija, videćete dodatne elemente 
u menijima Officea. U Wordu je 
to nova paleta (slika 2.9) koja 
sadrži alatke za konverziju do-
kumenta u PDF, konverziju do-
kumenta i slanje elektronskom 
poštom, i za konverziju doku-
menta i pokretanje postupka 
redakture.

Dve nove stavke su takođe doda-
te i u Wordov glavni meni. Meni 
Adobe PDF sadrži tri komande 
koje smo upravo opisali, kao i 
komandu za promenu parame-
tara konverzije. Meni Acrobat 
Comments omogućava da uveze-
te komentare iz PDF datoteke u 
Word i nastavite redakturu.
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Konverzija Wordovih datoteka na Macu OS X
Kada instalirate Acrobat 6 na Macu na kome se nalazi Office X, vide-
ćete paletu alatki koja je dodata u Word i sadrži ikonice Convert to 
PDF  i Convert to PDF and email .

1. Izaberite parametre konverzije koje hoćete da koristite (slika 
2.11); među ponuđenim opcijama su Standard, Press Quality, 
High Quality i Smallest File Size.

Slika 2.11 Izaberite parametre neposredno iz Distillera.

PDF datoteka biće snimljena u istom direktorijumu gde se 
nalazi izvorna datoteka.

2. Pritisnite dugme View File da biste otvorili datoteku u Acro-
batu; pritisnite dugme Done da biste se vratili u Office.

SAVET 7: Upotreba makroa PDFMaker u Wordu

Upotreba Distillera  
na Macu
Ikonica Convert to PDF pokre-
će Distiller u kome možete da 
zadate parametre konverzije, 
za razliku od Windowsa gde 
makro dozvoljava podešavanja 
unutar Officea.
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SAVET 

8  
Promena parametara 
konverzije PDFMakera

Prilikom konverzije dokumenata u PDF niste ograničeni na korišće-
nje jednog skupa opcija za konverziju. Možete da koristite jedan od 
nekoliko ugrađenih skupova parametara ili da napravite sopstveni 
skup koji se naziva opcije poslova (engl. job options). Izaberite opciju 
Adobe PDF > Change Conversion Settings da biste otvorili okvir za 
dijalog s četiri kartice. U ovom okviru za dijalog podešavate opcije 
štampanja i određujete složenost PDF datoteke i njenu veličinu:

1. Osnovne opcije birate na kartici Settings (slika 2.12). Ovde 
zadajete parametre konverzije tako što ih birate iz padajuće 
liste. Na ovom mestu birate i osnovne opcije za obradu doku-
menata, na primer, određujete želite li da vidite PDF datoteku 
u Acrobatu nakon konverzije.

Slika 2.12 Izmenu parametara počnite na kartici Settings.

2. Padajuća lista Conversion Settings sadrži četiri opcije (slika 
2.13):

 

Slika 2.13 Na raspolaganju vam  
je nekoliko ugrađenih skupova  
parametara konverzije.
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• Opcija Standard – podrazumevani skup parametara koristi 
se za konverziju i pregled jednostavnih poslovnih dokume-
nata. Rezolucija štampanja iznosi 600 dpi.

• Opcija High-quality – koristi se za visokokvalitetnu štampu; 
slike se štampaju u visokoj rezoluciji ali će u PDF datoteku 
biti uključen ograničen broj podataka o fontovima doku-
menta. Rezolucija štampanja je 2400 dpi.

• Opcija Press – koristi se za štampanje u visokoj rezoluciji 
na profesionalnim štamparskim mašinama i na uređajima 
kao što su osvetljivači. U rezultujuću datoteku dodaju se 
svi podaci. Ovaj skup parametara obuhvata podatke o svim 
fontovima koji su korišćeni u dokumentu.

• Opcija Smallest File Size – služi za dobijanje najmanjih 
datoteka; koristi se za slanje sadržaja na Web, elektronsku 
poštu i za gledanje dokumenta na ekranu. Slike su kompri-
movane i njihova rezolucija je smanjena.

3. Izaberite opcije koje odgovaraju izvornom programu. Doku-
mentu u Wordu možete da dodate obeleživače, veze i oznake.

4. Pritisnite jezičak kartice Security da biste zadali lozinke za 
datoteku (slika 2.14), prava pristupa sadržaju dokumenta, te 
dozvole za štampanje, gledanje i izdvajanje sadržaja.

Slika 2.14 Kartica Security omogućava da zadajete  
prava pristupa dokumentu.

SAVET 8: Promena parametara konverzije PDFMakera

Parametri konverzije  
u Acrobatu 5
Acrobat 5 koristi pet podrazume-
vanih skupova parametara kon-
verzije – Screen, Print, Press, 
CJKScreen i eBook. U Window-
su, opcije Acrobata 5 dostupne 
su u programima Adobe Page-
Maker i Adobe FrameMaker što 
omogućava korisnicima prethod-
ne verzije Acrobata da i dalje ko-
riste iste skupove parametara.
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5. Pritisnite jezičak kartice Word. Izmenite parametre za konver-
ziju elemenata iz Worda kao što su komentari i sadržaji u ele-
mente formatirane za PDF (slika 2.15).

Slika 2.15 Izaberite parametre konverzije koji su specifični za Word.

6. Pritisnite jezičak kartice Bookmarks da biste podesili struk-
turu obeleživača (slika 2.16). Kao osnovu za obeleživače u 
Acrobatu možete da koristite naslove ili stilove. Više podataka 
potražite u savetu 62.

Slika 2.16 Napravite obeleživače pomoću naslova ili stilova.

7. Pritisnite OK da biste zatvorili okvir za dijalog. U svakom tre-
nutku možete da se vratite na podrazumevani skup parame-
tara tako što ćete pritisnuti dugme Restore Defaults na dnu 
svake kartice (slika 2.17).

Slika 2.17 Upotrebite dugme Restore Defaults da biste vratili  
podrazumevane parametre.

Kretanje pomoću obele-
živača
U Acrobatu postoji više načina 
za jednostavnije kretanje po do-
kumentu. Obeleživači spadaju 
u najčešće alatke za kretanje. 
Kada označite naslove, slike 
i druge važne podatke u doku-
mentu, Acrobat će napraviti 
veze u oknu Bookmarks. Obeleži-
vači su detaljnije opisani 
u poglavlju 7.
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Poređenje parametara
Da vidimo šta se dešava kada konvertujemo istu datoteku pomoću različitih sku-
pova ugrađenih parametara.

Na slici 2.18 prikazane su datoteke različitih veličina. Datoteka koja je napra-
vljena pomoću skupa parametara Smallest File Size, ima najmanju veličinu. 
Opcija Press proizvodi najveće datoteke.

Slika 2.18 Različiti parametri prave datoteke različitih veličina.

Čak i ako ne štampate PDF datoteku, možete da vidite razliku između dejstva ne-
kih opcija. Na slici 2.19, leva stranica prikazuje deo dokumenta koji je konver-
tovan upotrebom opcije Press, a desna stranica prikazuje isti deo dokumenta 
koji je konvertovan pomoću opcije Smallest File Size. Jasno se uočava razlika 
u kvalitetu slike i slova.

Slika 2.19 Različiti parametri proizvode slike različitog kvaliteta.

SAVET 8: Promena parametara konverzije PDFMakera
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SAVET 

9  
Konverzija datoteka 
iz Excela i PowerPointa

Microsoft Excel i PowerPoint takođe mogu da koriste makro PDFMa-
ker, pa možete brzo i jednostavno da pretvorite tabele ili prezenta-
cije u Acrobatove dokumente.

U PowerPointu uradite sledeće:

1. Kada instalirate Acrobat 6 i otvorite PowerPoint, videćete 
paletu alatki PDFMaker 6.0 i meni Adobe PDF.

2. Izaberite opciju Adobe PDF > Change Conversion Settings da 
biste otvorili okvir za dijalog Acrobat PDFMaker.

3. Ovaj okvir za dijalog sadrži dve kartice. Na slici 2.20 prika-
zana je kartica Settings; kartica Security je ista u svim Office-
ovim programima (videti sliku 2.14).

Slika 2.20 Za konverziju dokumenata iz PowerPointa, zadajte opcije 
na karticama Settings i Security.

4. Na kartici Settings videćete padajuću listu sa istim opcijama i 
iste opcije za konverziju poput onih u programu Word (videti 
sliku 2.12). 



27

5. Pogledajte opcije u odeljku Application Settings. Neke od njih 
su globalne opcije Officea, kao što je opcija za dodavanje veza. 
Ostale opcije su specifične za prezentacije PowerPointa, poput 
opcija za konverziju multimedijalnih datoteka i za pravljenje 
prelaza.

Postupak konverzije je veoma sličan onome koji smo već opisali:

1. Otvorite Excel. Pronađite paletu alatki PDFMaker 6.0 i stavke u 
meniju Adobe PDF uključujući i onu koja postoji samo u Excelu 
(slika 1.21).

Slika 2.21 Radni list ili čitavu radnu svesku  
Excela možete da pretvorite u PDF.

2. Izaberite opciju Adobe PDF > Change Conversion Settings da 
biste otvorili okvir za dijalog Acrobat PDFMaker.

U ovom okviru za dijalog nalaze se dve iste kartice kao i u 
okviru za dijalog PowerPoint, a opcije su iste kao i u drugim 
Officeovim programima.

SAVET 9: Konverzija datoteka iz Excela i PowerPointa

Konverzija Excelovih  
radnih svezaka
U Excelovom meniju Adobe PDF 
videćete dodatnu komandu koja 
vam omogućava da konvertuje-
te čitavu radnu svesku. Excelo-
ve tabele su organizovane kao 
listovi u radnoj svesci. Koman-
da Convert to PDF odnosi se 
samo na aktivan list.
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SAVET 

10  
Konverzija Web stranica  
pomoću Internet Explorera

Kada prvi put pokrenete Microsoft Internet Explorer nakon instala-
cije Acrobata 6, uočićete paletu alatki Adobe PDF. Upotrebite je za 
rad s PDF datotekama dok ste povezani na Internet. Pritisnite jezi-
čak padajuće liste desno od ikonice Adobe PDF na paleti alatki da 
biste prikazali opcije menija (slika 2.22).

 
Slika 2.22 Skup stavki i menija  
dodat je Internet Exploreru.

• Da biste konvertovali dokument, pritisnite ikonicu ili izaberite 
opciju Convert Web Page to PDF. Otvara se okvir za dijalog u 
kome zadajete ime datoteke i određujete lokaciju na kojoj će 
biti snimljena. Pritisnite dugme Save da biste konvertovali 
datoteku.

• Pritisnite ikonicu Add Web Page to Existing PDF ili izaberite 
odgovarajuću opciju iz menija da biste sadržaj Web stranice 
dodali drugoj datoteci. U okviru za dijalog Open koji će se poja-
viti, izaberite datoteku i pritisnite dugme Save.

• Da biste Web stranicu konvertovali u PDF datoteku i odštampali 
je, pritisnite ikonicu Print Web Page. Otvoriće se okvir za dijalog 
štampača u kome možete da podesite parametre štampanja.

• Izaberite opciju Adobe PDF Explorer Bar da biste otvorili 
prozor Explorera na levoj strani prozora Internet Explorera 
(slika 2.23). Kada pronađete datoteku, pritisnite X u gornjem 
desnom uglu okna da biste je zatvorili.
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Slika 2.23 Upotrebite opciju Adobe PDF Explorer Bar da biste pronašli  
datoteke.

• Izaberite opciju Preferences da biste otvorili mali okvir za 
dijalog sa tri opcije koje možete da menjate (slika 2.24). Sve 
tri opcije su podrazumevano izabrane što je najpogodnije za 
većinu korisnika. 

Slika 2.24 Podesite ili promenite parametre konverzije  
u Internet Exploreru.

Koji su vaši parametri 
konverzije?
Ako redovno konvertujete dato-
teke sa Weba, razmotrite mo-
gućnost promene dva parame-
tra za obaveštenje (slika 2.24). 
Na primer, da li želite da potvr-
dite brisanje datoteke ili doda-
vanje stranice? Ako stranice na 
Webu konvertujete povremeno, 
potvrđivanje je dobra ideja. Na 
drugoj strani, ako često to radi-
te, svaki put ćete morati da za-
tvorite dijalog, potvrdite opciju 
ili zatvorite Acrobat, a to znači 
da činite dodatne korake koji 
mogu da vas uspore.

SAVET 10: Konverzija Web stranica pomoću Internet Explorera
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SAVET 

11  
Konverzija datoteka pomoću 
Acrobat Distillera

Acrobat Distiller se odnosi i na upravljački program za štampač i na 
program Acrobat Distiller. Koristite iste parametre bez obzira na to 
da li datoteke konvertujete tako što pritisnete ikonicu u izvornom 
programu ili ručno konvertujete datoteku u Distilleru. Parametri za 
konverziju su:

1. U Windowsu, izaberite opciju Start > Programs > Acrobat Dis-
tiller 6.0. Kao što možete da vidite na slici 2.25, Distiller je 
izdvojen od ostalih programa iz paketa Acrobat.

Slika 2.25 Acrobat Distiller i Acrobat Standard dva su odvojena  
programa.

Korisnički interfejs Distillera izgleda kao okvir za dijalog. U 
njemu ćete uočiti tri menija. Imajte u vidu da možete da birate 
skupove ugrađenih parametara, o čemu je bilo reči u savetu 8.

2. Izaberite ugrađene parametre koje ćete koristiti za konverziju 
ili napravite sopstvene parametre. 

3. Izaberite opciju File > Open da biste otvorili okvir za dijalog 
u kome birate datoteku za konverziju. Pronađite datoteku na 
računaru i pritisnite dugme Open.

Napomena
Distiller podržava datoteke u formatu .ps ili .prn. Format datoteka .ps kori-
sti programski jezik PostScript. Neki programi prave .prn umesto .ps dato-
teka; drugi programi prave .prn datoteke ako u štampi izaberete opciju 
Print to File. Oba formata datoteka zasnovana su na upravljačkim progra-
mima za štampač instaliranim na vašem računaru.
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4. Distiller će obraditi datoteku. Pojavljuje se traka na kojoj se 
vidi napredovanje postupka konverzije, izraženo u procentima. 
(slika 2.26).

 

Slika 2.26 Pogledajte 
informacije o datoteci 
koja se obrađuje.

5. Konvertujte i preostale datoteke ili zatvorite Distiller. Konver-
tovanu PostScript datoteku možete da koristite kao i sve druge 
PDF datoteke.

Napomena
Izaberite opciju File > Preferences da biste otvorili mali okvir za dijalog pri-
kazan na slici 2.27. Ukoliko radite na Macu, izaberite opciju Distiller > Pre-
ferences. Na raspolaganju vam je nekoliko opcija, poput one za pregled 
napravljenih datoteka u Acrobatu i upravljanje zapisničkim datotekama.

 

Slika 2.27 Podesite  
parametre u Distilleru, 
kao što su pregled PDF  
datoteka u Acrobatu 
i brisanje zapisničke 
datoteke.

SAVET 11: Konverzija datoteka pomoću Acrobat Distillera

Konverzija pomoću  
Distillera
Neki programi, u koje spadaju 
starije verzije QuarkXPressa, ne 
mogu odmah da naprave PDF 
datoteku. Moraćete najpre da 
napravite PostScript datoteku i 
da je potom konvertujete u PDF 
pomoću Distillera. Distiller vam 
je neophodan i ako hoćete da 
koristite napredne funkcije kao 
što su parametri Distillera. Neki 
programi mogu da izvezu dato-
teku kao PDF ili da je štampaju 
u formatu PDF. Ako program ne 
može da napravi PDF datoteku, 
pokušajte da dokument snimi-
te kao PostScript datoteku s 
nastavkom .ps; ili, pokušajte 
da napravite datoteku s nastav-
kom .prn u drugom formatu koji 
Distiller takođe podržava.
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SAVET 

12  
Pravljenje novog skupa  
parametara za konverziju

Parametre konverzije možete da prilagodite sopstvenom poslu tako 
što ćete početi da ih pravite od početka ili izmeniti podrazumevane 
parametre. Acrobat ima opcije koje omogućavaju da pravite varija-
cije podrazumevanih parametara. Za to ćete koristiti makroe PDFMa-
kera ili okvire za dijalog Distillera. Ovaj savet vam pokazuje kako da 
prilagodite parametre pomoću Distillera:

1. U Distilleru izaberite jedan od podrazumevanih skupova para-
metara koji će vam poslužiti kao osnova za sopstvene parame-
tre. Iako možete da krenete od početka, mnogo je jednostav-
nije da promenite skup parametara koji je najpribližniji onome 
što vam treba. Kao osnova za nove parametre, u primeru je 
korišćen podrazumevani skup parametara High Quality.

2. Izaberite opciju Settings > Edit Adobe PDF Settings.

3. Otvoriće se okvir za dijalog High Quality – Adobe PDF Settings 
(slika 2.28). Ovaj okvir za dijalog ima pet kartica.

Slika 2.28 Započnite s Distillerovim podrazumevanim  
parametrima i uskladite ih sa sopstvenim potrebama.
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4. Na kartici General možete da menjate sledeće parametre:

• Compatibillity (kompatibilnost) – Podrazumevana opcija je 
Acrobat 5.0 (PDF 1.4). U zavisnosti od toga koju verziju 
Acrobata ili Acrobat Readera imaju korisnici vaših dokume-
nata, možete da izaberete opciju za kompatibilnost s pret-
hodnim verzijama Acrobata sve do verzije 3. Stare verzije 
programa imaju manje opcija za parametre bezbednosti, 
ugrađivanja fontova i upravljanja bojom. Na primer, bezbed-
nosni parametri Acrobata 6 nisu upotrebljivi u Acrobatu 3.

• Resolution (rezolucija) – Ovu opciju treba podesiti tako 
da odgovara rezoluciji PostScript štampača. Viša rezolucija 
uglavnom daje kvalitetnije ali i veće datoteke. Rezolucija 
se ovde odnosi na broj koraka u prelivu ili slivanju. Preliv na 
levoj strani slike 2.29 isti je kao i preliv na desnoj strani; 
jedina razlika je u rezoluciji.

 

Slika 2.29 Rezolucija  
određuje broj koraka  
u prelivu ili slivanju.

• Embed Thumbnails (ugrađivanje minijaturnih prikaza) 
– Minijaturni prikazi stranica koriste se za kretanje po 
dokumentu. U prethodnim verzijama Acrobata morali ste da 
zadate pravljenje minijaturnih prikaza. Acrobat 5 i 6 dina-
mički prave minijaturne prikaze. Ukoliko ne nameravate da 
štampate dokument pomoću starijih verzija Acrobat Rea-
dera, nemojte da izaberete ovu opciju. Ona će nepotrebno 
uvećati datoteku. 

SAVET 12: Pravljenje novog skupa parametara za konverziju

Zadavanje opsega  
stranica
Kartica General sadrži opciju za 
dodavanje opsega stranica. Ko-
ristite ovu opciju samo ako ste 
sigurni da su vaši parametri za 
jednokratnu upotrebu. Ako zada-
te opseg stranica kada zadajete 
skup parametara i potom pono-
vo upotrebite ove parametre, 
konvertovaćete samo one strani-
ce koje ste zadali na kartici Ge-
neral. Ovo može da dovede do 
problema čije će vam rešavanje 
oduzeti vreme ukoliko ne koristi-
te podrazumevane parametre 
jer ne možete da shvatite šta se 
desilo s vašim stranicama (sa 
onima koje nisu unutar zadatog 
opsega na kartici General). 
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5. Možda će biti neophodno da na kartici Images (slika 2.30) 
podesite i promenite parametre nekoliko puta ukoliko konver-
tujete datoteke sa složenim slikama. Proučite sledeće opcije:

Slika 2.30 Menjajte i proveravajte parametre na kartici Images.

• Downsample (smanjivanje rezolucije) – Oba primera prika-
zuju istu sliku (slika 2.31); leva slika ima mnogo nižu rezo-
luciju od desne; sa ovakvom vrstom slika u PDF datoteci, 
uglavnom nećete hteti da smanjite rezoluciju. 

 

Slika 2.31 Pre nego što 
smanjite rezoluciju slika, 
razmotrite kako vaši  
čitaoci koriste dokument. 
Dokument na levoj strani 
mnogo se teže čita nego  
dokument na desnoj strani.

• Compression/Image Quality (kompresija/kvalitet slike) – Iza-
berite opcije u zavisnosti od slika u dokumentu (u sivim nijan-
sama, u boji ili crno-belih). Različite parametre kompresije 
koristićete u zavisnosti od vrste slike (pogledajte savet 6).

Manje ili veće  
smanjivanje rezolucije
Ako je rezolucija slike veća od 
zadate, nekoliko piksela biće 
kombinovano tako da čine je-
dan veći piksel, čime se smanju-
je rezolucija. Na osnovu toga 
šta će vaši korisnici raditi s da-
totekom, možete da povećate ili 
smanjite nivo smanjenja rezolu-
cija. Za slike kao što su mape 
(gde korisnik povećava veličinu 
prikaza), visoka rezolucija dopri-
nosi većoj čitljivosti.
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• Nazubljene ivice na crno-belim slikama ublažićete ako 
uključite opciju Anti-alias to gray (slika 2.32).

 
Slika 2.32 Desna slika prikazuje efekat 
umekšavanja nazubljenih ivica.

6. Na kartici Fonts (slika 2.33) zadajte ugrađivanje fontova ili 
pravljenje podskupova slovnih znakova ukoliko je procenat 
upotrebljenih znakova manji od zadate vrednosti. Ako koristite 
neobične fontove ili ukoliko prelom vašeg dokumenta umno-
gome zavisi od fontova, obavezno ugradite te fontove. Da biste 
ugradili samo deo skupa slovnih znakova koji postoje u fontu, 
izaberite pravljenje podskupova. Nemojte da unesete nisku 
vrednost ukoliko očekujete da će se tekst stranice menjati.

Slika 2.33 Ugrađivanjem fontova očuvaćete izgled dokumenta.

SAVET 12: Pravljenje novog skupa parametara za konverziju

Ugrađivati ili ne...
Fontove obavezno ugradite da 
biste uštedeli vreme ukoliko 
radite s različitim parametrima 
ali istim skupom datoteka. Na 
primer, ako radite na šablonu 
za firmu u kome se stalno kori-
ste određeni fontovi, izaberite 
fontove u listi Fonts i pritisnite 
dugme Add da biste ih dodali 
na listu Always Embed. Kad 
nadalje budete pravili PDF dato-
teke, nećete morati da pamtite 
da li se fontovi ugrađuju ili se 
ne ugrađuju.
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7. Na kartici Color (slika 2.34) izaberite parametre koji odgova-
raju datotekama korišćenim u izvornim aplikacijama kao što 
su Photoshop ili Illustrator. Opcije na ovoj kartici zavise od 
parametara boja koje ste izabrali. Ako šaljete datoteke na 
štampanje, konsultujte se sa štamparom oko parametara.

Slika 2.34 Opširan skup parametara za boju.

8. Ukoliko su vam nepoznati pojmovi poput konvencije o struk-
turi dokumenta (engl. Document Structuring Conventions) ili 
slični, nemojte da menjate opcije na kartici Advanced (slika 
2.35). Parametri na ovoj kartici opisuju postupak konverzije 
iz PostScripta u PDF. Pogledajmo dve podrazumevane opcije:

Upotreba modela RGB  
za ekranski prikaz
Ako pravite datoteke za gleda-
nje na ekranu, za model boje iza-
berite RGB a ne CMYK. RGB je 
prirodan model boje monitora 
i ne zahteva nikakvu konverziju 
što ubrzava prikazivanje doku-
menata na ekranu.
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Slika 2.35 Nema velike potrebe za promenom  
podrazumevanih parametara na kartici Advanced.

• Opcija Convert gradients to smooth shades, konvertuje pre-
live iz više programa u koje spadaju Macromedia FreeHand, 
QuarkExpress, Adobe Illustrator i Microsoft PowerPoint. Ova 
opcija pravi manje PDF datoteke i ponekad utiče na kvalitet-
niju štampu.

• Opcija Save original JPEG images in PDF if possible, obra-
đuje JPEG slike (koje su komprimovane) bez ponovne kom-
presije, što znatno ubrzava rad.

SAVET 12: Pravljenje novog skupa parametara za konverziju

Snimanje parametara
Parametri konverzije snimaju 
se u posebnom direktorijumu. 
Na Windowsu XP datoteke 
parametara smeštene su u di-
rektorijumu Settings unutar 
direktorijuma Adobe PDF 6 koji 
je u sistemskom direktorijumu 
Shared Documents. Skupovi 
parametara su u istom direkto-
rijumu, pa su dostupni makrou 
PDFMaker, Acrobatu i Distilleru.
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9. Izaberite opciju Save As da biste otvorili okvir dijalog Save 
Adobe PDF Settings As. Zadajte ime datoteke i pritisnite dugme 
Save (slika 2.36). Novi skup parametara konverzije snimljen 
je s nastavkom .joboptions.

Slika 2.36 Skup parametara konverzije je snimljen  
s nastavkom .joboptions.

Deljenje parametara
Parametre konverzije možete 
da podelite s drugim korisnici-
ma. Elektronskom poštom po-
šaljite datoteku .joboptions na 
isti način kao što biste poslali i 
druge datoteke. Primaoci dato-
teke smestiće je u direktorijum 
na svom računaru. Kada sledeći 
put pristupe okviru za dijalog za 
parametre u makrou PDFMaker, 
Acrobatu ili Distilleru, deljeni 
parametri su spremni 
za upotrebu.
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SAVET 

13  
Pravljenje PDF dokumenta 
pomoću datoteke u Acrobatu

PDF datoteke možete da pravite iz Acrobata 6. Kada pritisnete dugme 
Create PDF, na raspolaganju vam je nekoliko opcija.

Napomena
Kada otvorite meni Create PDF, videćete da je njegova poslednja stavka 
How To... Create PDF. Pritisnite tu stavku da biste otvorili skup datoteka 
za pomoć sa opisom različitih opcija za pravljenje PDF dokumenata.

1. Pritisnite dugme Create PDF da biste prikazali meni sa slike 
2.37.

 
Slika 2.37 Meni Create PDF u Acrobatu  
sadrži nekoliko opcija za konverziju datoteka.

2. Izaberite prvu opciju, From File. Pojaviće se okvir za dijalog 
Open.

3. Izaberite datoteku koju hoćete da konvertujete u PDF (slika 
2.38) i pritisnite dugme Open.

Slika 2.38 Izaberite datoteku koju hoćete da konvertujete.

SAVET 13: Pravljenje PDF dokumenta pomoću datoteke u Acrobatu
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4.  Videćete prozor sa indikatorom napredovanja (postoje dva raz-
ličita prozora sa indikatorom napredovanja, u zavisnosti od for-
mata izabrane datoteke). Acrobat izvršava makro koji otvara 
datoteku u izvornom programu i konvertuje je u PDF.

Ukoliko je datoteka napravljena u programu koji podržava PDFMa-
ker (kao Wordova datoteka koju koristim u primeru), Acrobat će 
upotrebiti PDFMaker s tekućim parametrima (slika 2.39). 

Slika 2.39 Ako program izvornog dokumenta podržava  
makro PDFMaker, Acrobat će iskoristiti taj makro.

Kada je datoteka iz programa u koji nije ugrađen makro PDFMa-
ker, Acrobat će otvoriti program i štampati datoteku pomoću 
Adobe PDF Convertera (slika 2.40).

Slika 2.40 Adobe PDF Converter se pokreće ako program  
u kome je napravljen izvorni dokument ne koristi makro PDFMaker.

5. Konvertovana datoteka biće otvorena u Acrobatu. Datoteci je 
dodeljeno ime na osnovu imena izvorne datoteke, ali ona još 
nije snimljena u formatu PDF. Izaberite opciju File > Save da 
biste snimili datoteku kao PDF dokument.

Napomena
Ako datoteke konvertujete pomoću makroa PDFMaker – na primer, poput 
datoteka napravljenih u Wordu ili PowerPointu – poslednje opcije koje su 
korišćene za konverziju primenjuju se na datoteku.

Gde da konvertujete  
dokument
Da li treba da konvertujete do-
kument u izvornom programu 
ili u Acrobatu? Odgovor je – za-
visi. Ukoliko radite u nekom 
programu i znate da će vam biti 
potrebna i PDF verzija dokumen-
ta, generišite dokument iz tog 
programa. Ako radite u Acroba-
tu, i zaključite da vam treba PDF 
datoteka, napravite tu datoteku 
iz Acrobata. 

Čak i ako radite u Acrobatu, i 
planirate da napravite datoteke 
iz programa u koje je ugrađen 
makro PDFMaker, pri čemu se 
ne sećate parametara koje ste 
koristili poslednji put ili znate 
da treba da ih promenite, oba-
vite konverziju u izvornom pro-
gramu a ne u Acrobatu. Bolje je 
tako nego da napravite datote-
ku koja je konvertovana s po-
grešnim parametrima jer ćete 
posle morati da ponovite čitav 
postupak.



41

SAVET 

14  
Pravljenje PDF dokumenta 
od više datoteka u Acrobatu

Opcija za konverziju skupa datoteka odličan je način da organizujete 
posao. Umesto da se prisećate koje su vam datoteke potrebne i gde 
ste ih smestili, da potom ručno konvertujete sve datoteke i onda ih 
jednu po jednu objedinjujete u Acrobatu, upotrebite opciju Create 
PDF Multiple Documents. Otvoriće se okvir za dijalog koji omogu-
ćava da brzo objedinite dokumente i datoteke (u PDF formatima ili 
drugim formatima), da ih organizujete i imate uvid u sadržaj konač-
nih dokumenata pre nego što napravite datoteku. Ušteda vremena 
je više nego očigledna!

1. Pritisnite dugme Create PDF da biste prikazali opcije menija.

2. Izaberite opciju From Multiple Files da biste otvorili okvir za 
dijalog Create PDF from Multiple Documents (slika 2.41).

Slika 2.41 Objedinite grupu datoteka pomoću okvira za dijalog 
Create PDF from Multiple Documents.

3. Pritisnite dugme Browse da biste otvorili okvir za dijalog 
Open.

4. Izaberite prvu datoteku koju ćete dodati skupu datoteka i pri-
tisnite dugme Add.

5. Prozor za izbor datoteka se zatvara i Acrobat dodaje datoteku. 
Ponovite korake 3 i 4 dok ne izaberete sve datoteke koje hoćete 
da smestite u skup datoteka.

SAVET 14: Pravljenje PDF dokumenta od više datoteka u Acrobatu
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6. Sadržaj organizujte u oknu Files to Combine. Pritisnite ime 
datoteke da biste aktivirali dugmad na levoj strani prozora.

7. Pomerajte datoteke ponaosob gore-dole ili ih brišite sve dok 
skup datoteka ne bude odgovarao onome što ste zamislili 
(slika 2.42).

Slika 2.42 Promenite poredak datoteka pomoću dugmadi  
Arrange Files.

8. Pritisnite OK. Prozor se zatvara, a Acrobat pravi nov PDF doku-
ment. Svaka datoteka biće zasebno obrađena, a sve datoteke 
na spisku koje nisu u formatu PDF biće konvertovane u PDF.

Slika 2.43 prikazuje minijaturne stranice. Dokument je stra-
nica 1, potom slede tri slike koje su pretvorene u PDF format i 
na kraju je sve kombinovano u Binder1.pdf.

 

Slika 2.43 Izabrani dokumenti su prikazani 
kao minijaturne stranice, a potom su  
objedinjeni u PDF dokument.

9. Izaberite opciju File > Save da biste snimili dokument. Time je 
postupak objedinjavanja okončan.

Izvorne aplikacije
Prilikom konverzije sadržaja i 
objedinjavanja dokumenata, za 
sve datoteke na spisku koje ne 
može neposredno da učita, Ac-
robat otvara izvorne aplikacije. 
To znači da ne možete da doda-
te datoteku napravljenu u Pho-
toshopu, koju Acrobat ne može 
da otvori, ako Photoshop nije 
instaliran na računaru.
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SAVET 

15  
Pravljenje PDF dokumenta 
od Web stranica

Stranicu Web lokacije možete lako da preuzmete i pretvorite u PDF 
datoteku pomoću makroa Adobe PDF koji je instaliran u Internet 
Exploreru. Da biste iz Acrobata preuzeli čitavu Web lokaciju i kontro-
lisali njen sadržaj i način prikazivanja u PDF dokumentu, postupite 
na sledeći način:

1. Pritisnite dugme Create PDF da biste prikazali meni sa slike 
2.44. 

 
Slika 2.44 Izaberite opciju From Web Page 
da biste započeli konverziju.

2. Izaberite opciju From Web Page da biste otvorili okvir za dija-
log Create PDF from Web Page (slika 2.45).

 

Slika 2.45  
Unesite adresu 
Web lokacije.

3. Datoteci koju hoćete da konvertujete možete pristupiti na tri 
načina, zavisno od lokacije i tipa datoteke:

• Ako je datoteka na Internetu, unesite njenu adresu.

• Pritisnite strelicu desno od polja za adresu da biste učitali 
datoteke koje su već otvarane u Acrobatu.

• Pritisnite dugme Browse da biste otvorili okvir za dijalog 
Select File to Open i učitali datoteku koja je na čvrstom 
disku vašeg računara.

4. Pritisnite dugme Create da biste pokrenuli konverziju. Okvir za 
dijalog Download Status pokazuje aktivne veze tokom preuzi-
manja materijala, te imena, veličinu i lokacije datoteka (slika 
2.46).

SAVET 15: Pravljenje PDF dokumenta od Web stranica

Mnogo stranica,  
malo vremena
U okviru za dijalog Create PDF 
from Web Page, određujete ko-
liko će nivoa Web lokacija biti 
preuzeto. Podrazumevana vred-
nost je 1. Nemojte da promeni-
te ovaj broj pre nego što dobro 
razmislite. Nivo 1 odnosi se na 
prvi skup stranica Web lokacije, 
tj. one stranice koje vidite kada 
unesete njihovu adresu u od-
govarajuće polje čitača Weba. 
Dodatni nivoi dopiru do većeg 
broja stranica. Ako izaberete 
opciju Get Entire Site, preuze-
ćete čitavu lokaciju, bez obzira 
na to da li ona sadrži 10 ili 1000 
stranica.

Iako je sigurnije i jednostavnije 
da ostavite podrazumevani nivo 
1, šta da učinite ako uvezete 
stranicu i zaključite da su vam 
potrebne i dodatne stranice? 
Srećom, nove stranice se lako 
dodaju. Izaberite opciju Advan-
ced > Web Capture > Append 
Web Page da biste otvorili okvir 
za dijalog Add to PDF from Web 
Page, koji je istovetan okviru za 
dijalog Create PDF from Web 
Page. Izaberite nivo i strani-
ce će biti dodate postojećem 
dokumentu.
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Slika 2.46 Tok  
konverzije možete 
da pratite u okviru 
za dijalog Download 
Status.

5. Kada preuzmete materijal, Acrobat će prikazati novu PDF dato-
teku u prozoru dokumenta, a struktura dokumenta pojaviće se 
u kartici Bookmarks (slika 2.47).

Slika 2.47 Nov PDF dokument automatski će se otvoriti u Acrobatu.

6. Pregledajte dokument. Uočićete da je na svaku stranicu dodato 
zaglavlje i podnožje. U zaglavlju je ime Web stranice; podnožje 
sadrži adresu stranice, broj stranica i datum i vreme preuzimanja 
(slika 2.48).

 

Slika 2.48 Stranicama  
se podrazumevano dodaju 
zaglavlje i podnožje.

7. Izaberite opciju File > Save da biste snimili Web stranicu koja 
je pretvorena u PDF dokument.
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SAVET 

16  
Promena parametara  
za preuzimanje Web stranica

Acrobat preuzima Web stranice na osnovu podrazumevanih parame-
tara za formate datoteka i formatiranje stranica. Parametre ćete pri-
lagoditi svojim zahtevima prateći sledeće korake:

1. Pritisnite dugme Create PDF i izaberite opciju From Web Page 
da biste otvorili okvir za dijalog Create PDF from Web Page. 
Pritisnite dugme Settings na donjoj desnoj strani okvira za 
dijalog (slika 2.49).

 

Slika 2.49 Da biste podesili parametre 
preuzimanja Web stranica, pritisnite 
dugme Settings.

2. Otvoriće se okvir za dijalog Web Page Conversion Settings. Na 
kartici General podešavate parametre tipova datoteka i PDF 
dokumenata (slika 2.50).

Slika 2.50 Podesite parametre tipova datoteka i PDF dokumenata.

3. Na dnu okvira za dijalog videćete podrazumevane opcije PDF 
dokumenata, kao što su opcije obeleživača, zaglavlje i pod-
nožje. Možete da izaberete i druge opcije ili da poništite izbor. 
onih koje su podrazumevano izabrane.

U gornjem delu kartice General nalazi se lista formata dato-
teka koje možete da uvezete tokom preuzimanja Web stranice. 
Parametre formata HTML i Plain Text možete da promenite.

SAVET 16: Promena parametara za preuzimanje Web stranica
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4. Iz liste tipova datoteka izaberite HTML, čime ćete aktivirati 
dugme Settings. Kada pritisnete ovo dugme, otvoriće se okvir 
za dijalog HTML Conversion Settings (slika 2.51).

Slika 2.51 Parametre tipova datoteka HTML i Plain Text  
možete da menjate.

5. Podesite opcije za konverziju HTML datoteka. U opcije koje 
možete da promenite spadaju boja i pozadina. U drugoj kartici 
podešavate font, jezik i način kodiranja teksta.

6. Pritisnite OK da biste zatvorili okvir za dijalog HTML Conver-
sion Settings i vratili se u okvir za dijalog Web Page Conversion 
Settings.

Pripazite na parametre
Kada promenite parametre pre-
uzimanja Web stranica, oni će 
ostati takvi sve dok ih ponovo 
ne promenite. Zatvaranje i po-
novno pokretanje Acrobata ne 
utiče na parametre.
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Opcije za formatiranje stranica
Druga kartica okvira za dijalog Web Page Conversion Settings sadrži 
opcije za formatiranje stranica:

1. Izaberite standardne opcije za formatiranje stranica kao što su 
veličina stranice, orijentacija i margine (slika 2.52).

Slika 2.52 U ovom okviru za dijalog možete da promenite parametre 
formatiranja stranica.

2. Ponovo pritisnite OK da biste zatvorili okvir za dijalog i vratili 
se u okvir za dijalog Create PDF from Web Page.

3. Pritisnite OK da biste započeli konverziju. Slika 2.53 prikazuje 
istu stranicu kao na slici 2.47 koja je preuzeta pomoću izme-
njenih parametara. U ovom primeru konvertovali smo istu Web 
stranicu koristeći drugačiju boju teksta i veličinu stranice.

 

Slika 2.53 Ova stra-
nica prikazuje ishod 
promene parametara 
kao što su veličina 
stranice i boja slova.

SAVET 16: Promena parametara za preuzimanje Web stranica
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SAVET 

17  
Pravljenje PDF dokumenata 
pomoću skenera

Ponekad ćete ustanoviti da nemate originalnu datoteku dokumenta. 
Ako imate odštampanu kopiju dokumenta, možete da napravite 
njenu verziju u formatu PDF pomoću skenera.

1. Pritisnite dugme Create PDF da biste prikazali meni sa slike 
2.54.

 

Slika 2.54 Izaberite opciju 
za pravljenje PDF dokumenta 
pomoću skenera.

2. Izaberite četvrtu opciju, From Scanner, da biste otvorili okvir 
za dijalog Create PDF From Scanner (slika 2.55).

Slika 2.55 Izaberite skener i potom odaberite parametre konverzije.
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3. Izaberite skener iz padajuće liste Device, i potom iz padajuće 
liste Format izaberite jednostrano ili dvostrano skeniranje.

4. Zadajte gde će skenirana stranica biti snimljena. Na slici 2.55 
jedina dostupna opcija je nov dokument; ako su drugi doku-
menti otvoreni u Acrobatu, možete im dodati skeniranu dato-
teku.

5. Ako treba, podesite opcije za kompresiju, kompatibilnost i 
senke.

6. Pritisnite dugme Scan. Acrobat će otvoriti okvir za dijalog upra-
vljačkog programa vašeg skenera. Konkretni parametri zavise 
od skenera i od upravljačkog programa. Da biste ih podesili, 
proučite uputstvo koje ste dobili uz skener i potom započnite 
skeniranje. Po završetku ovog procesa, okvir za dijalog upra-
vljačkog programa skenera se zatvara a skenirani dokument 
otvara se u Acrobatu (slika 2.56).

 

Slika 2.56 Kada se 
skeniranje završi, 
dokument se otvara 
u Acrobatu.

7. Izaberite opciju File > Save i snimite PDF dokument.

Saveti za skeniranje
Mnogo toga možete učiniti da 
bi slika stranica koje skenirate 
bila jasnija pogotovo ako se na 
njima nalazi tekst. Probajte ne-
ke od ovih saveta:

• Izaberite rezoluciju od 200 
dpi ako je tekst na stranici 
krupan, 300 dpi za tekst nor-
malne veličine (10-12 pt) i 
rezoluciju skeniranja od 400 
do 600 dpi za sitan tekst.

• Izaberite režim crno-belog 
(jednobitnog) skeniranja za 
tekst.

• Eksperimentišite sa osvetlje-
njem i kontrastom da biste 
smanjili uticaj obojene po-
zadine na tekst koji nije baš 
savršen.

• Unapred odlučite jesu li slike 
važnije od teksta ili je obrnu-
to. Ako koristite parametre za 
uređeni ili polutonski raster, 
slike će izgledati bolje, ali će 
se tekst teže prepoznati.

Slike skenirajte u rezoluciji od 
200 do 600 dpi. Proverite da li 
na disku ima dovoljno prostora 
za smeštanje slika, pogotovo 
ako skenirate veliki broj slika. 
RGB slika s 24-bitnom paletom 
boja i rezolucijom od 300 dpi, for-
mata A5 zauzima preko 12 MB.

SAVET 17: Pravljenje PDF dokumenata pomoću skenera
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Tekst ili slika teksta?
Većina datoteka koje konvertujete u PDF sastoji se od teksta i slika. 
Sadržaj stranica u PDF dokumentu možete da menjate pomoću više 
alatki. PDF datoteke dobijene skeniranjem ili iz programa kao što je 
Photoshop, uvek su slike; ne možete da menjate sadržaj takvih dato-
teka. Evo kako da brzo uočite razliku:

1. Pritisnite dugme Select Text na paleti alatki Basic. Mišem priti-
snite deo teksta u dokumentu. Ako ugledate vertikalni pulsira-
jući kursor, stranica sadrži tekst (slika 2.57).

 

Slika 2.57 Ukoliko ugledate 
vertikalni pulsirajući kursor, 
stranica sadrži tekst.

2. Ako mišem pritisnete tekst u dokumentu i ništa se ne dogodi, 
najverovatnije imate PDF u obliku slike. Da biste to proverili, 
pritisnite padajuću listu desno od alatke Select Text i izaberite 
opciju Select Image. Potom mišem pritisnite stranicu. Ako je 
izabrana cela stranica – reč je o slici (slika 2.58).

 

Slika 2.58 Upotrebite  
alatku Select Image da 
biste izabrali grafičke 
objekte na stranici. Ako 
je izabrana cela stranica, 
znaćete da je cela stranica 
slika.
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SAVET 

18  
Uvoženje izmenljivog teksta 
iz skeniranog dokumenta

PDF dokument napravljen skeniranjem samo je slika stranice, što 
znači da ne možete pristupiti njenom sadržaju da biste izdvajali slike 
ili menjali tekst. Međutim, pomoću alatke Paper Capture možete da 
pretvorite sliku dokumenta u pravi tekst. Ovaj postupak se naziva 
optičko prepoznavanje slova (engl. Optical Character Recognition, 
OCR). Acrobat će pokušati da protumači sliku znaka kao slovo ili 
broj. Po završetku procesa OCR, pregledajte dobijeni dokument kako 
biste proverili da li je Acrobat ispravno prepoznao njegov sadržaj. 
Do zabune i pogrešnog prepoznavanja najčešće dolazi zbog sličnih 
znakova, kao što su slovo I i broj 1.

Da bi Acrobat prepoznao sadržaj skeniranog dokumenta, sledite 
naredna uputstva:

1. Izaberite opciju Document > Paper Capture > Start Capture 
(slika 2.59). Otvoriće se okvir za dijalog Paper Capture.

 

Slika 2.59 Upotrebite 
alatku Paper Capture  
da biste sliku dokumenta 
pretvorili u tekst.

2. Za dokumente sa više stranica možete zadati da Acrobat obradi 
tekuću stranicu ili proizvoljan niz stranica u dokumentu (slika 
2.60).

 

Slika 2.60 Zadajte broj stranica 
ili brojeve stranica čiji sadržaj 
Acrobat treba da prepozna.

SAVET 18: Uvoženje izmenljivog teksta iz skeniranog dokumenta

Morate li da konvertujete 
skeniranu stranicu?
Kada skenirate neki uzorak i 
učitate ga u Acrobat, dobićete 
tekst i slike koje nije moguće 
menjati. Dobijeni rezultat može-
te da pretvorite u čitljiv tekst, 
ali da li je to vredno truda?

Najkraći odgovor bio bi: zavisi. 
Zbog čega uopšte treba da ske-
nirate stranice i učitavate ih u 
Acrobat? Da li vam treba samo 
slika za arhivu ili da biste je ko-
ristili kao deo paketa podataka 
za podršku korisnicima? U oba 
slučaja konverzija sadržaja naj-
verovatnije nije neophodna.

Evo nekih razloga zbog kojih tre-
ba da konvertujete sliku strani-
ce u tekst i slike koje je moguće 
obrađivati i pretraživati:

• Ukoliko treba da pretražujete 
tekst, na primer u skupu doku-
menata.

• Da bi sadržaj bio dostupan 
korisnicima kojima su neo-
phodni programi za čitanje 
sadržaja ekrana ili drugi po-
moćni uređaji. 

• Kada hoćete da ponovo kori-
stite slike dokumenta a ne-
mate izvorne materijale.

• Ako sadržaj PDF dokumenta 
koristite za različite namene, 
na primer, za Web stranicu ili 
za tekstualni dokument.
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3. Pritisnite dugme Edit da biste otvorili okvir za dijalog Paper 
Capture Settings. Iz padajuće liste PDF Output Style, izaberite 
opciju Formatted Text & Graphics (slika 2.61). Na taj način će 
svi delovi sadržaja biti konvertovani kao zasebni elementi.

 

Slika 2.61 Pretvorite  
sadržaj dokumenta  
u zasebne tekstualne  
i grafičke objekte.

4. Pritisnite OK da biste se vratili u okvir za dijalog Paper Cap-
ture. Pritisnite OK da biste započeli proces prepoznavanja sadr-
žaja stranica.

Indikator napredovanja biće prikazan na ekranu dok traje 
obrada dokumenta. U zavisnosti od veličine i složenosti doku-
menta, proces može da potraje minut ili dva. Kad se završi, 
indikator napredovanja nestaje.

Ispravljanje slovnih grešaka
Pretvaranje sličica, slova i brojeva u prava slova i brojeve, jeste postu-
pak u kome program može pogrešno protumačiti neke oblike. Njih 
nazivamo sumnjivim znakovima. Takve znakove možete da proverite 
jedan po jedan, na sledeći način:

1. Izaberite opciju Document > Paper Capture > Show All OCR 
Suspects. Svi delovi sadržaja stranice koje treba da potvrdite, 
uokvireni su crvenim pravougaonicima (slika 2.62).

 

Slika 2.62 Sumnjive reči  
i znakovi uokvireni su  
crvenim pravougaonicima.
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2. Izaberite opciju Document > Paper Capture > Show First OCR 
Suspect. Otvoriće se okvir za dijalog Find Element i sumnjivi 
delovi sadržaja stranice prikazaće se jedan po jedan. Ponekad 
su sumnjivi elementi ispravno napisane reči koje ne morate da 
proveravate. Na slici 2.63 reč locations praćena em crticom 
morala je da se proveri. Ako je tumačenje Acrobata netačno, 
izaberite tekst i zamenite ga ispravnim slovima ili brojevima.

 

Slika 2.63 Sumnjiv sadržaj 
stranice prikazuje se  
objekat po objekat.

3. Izaberite opciju Tools > Advanced Editing > TouchUp Text.

4. Alatkom TouchUp Text pritisnite početak sumnjive reči i prevu-
cite da biste je izabrali.

5. Unesite nov tekst.

6. Pritisnite dugme Accept and Find. Kad odobrite novo tumače-
nje teksta, Acrobat će prikazati naredne sumnjive elemente.

7. Nastavite proveru dokumenta. Pritisnite dugme Close da biste 
zatvorili okvir za dijalog.

8. Snimite dokument kada proverite rezultate rada opcije Paper 
Capture.

SAVET 18: Uvoženje izmenljivog teksta iz skeniranog dokumenta

Dežurni sumnjivci
Evo nekoliko saveta za prepo-
znavanje sadržaja s minimalnim 
brojem sumnjivih elemenata:

• Procenite sadržaj dokumen-
ta. Ustanovite je li dovoljno 
da samo skenirate dokument 
ili morate da ga skenirate i 
prepoznate njegov sadržaj.

• Ako planirate da prepoznate 
sadržaj dokumenta, podesite 
rezoluciju skeniranja – 200 
do 600 dpi za crno-bele uzor-
ke i 200 do 400 dpi za uzorke 
u sivim nijansama ili u boji. 
U protivnom, konverzija neće 
moći da se obavi, pojaviće se 
upozorenje i moraćete pono-
vo da skenirate dokument.

• Neki fontovi i pojedine boje 
nisu pogodni za prepoznava-
nje teksta. Postoje i specijal-
ni fontovi namenjeni optič-
kom prepoznavanju teksta, 
ali će svaki jasan font (serifni 
ili beserifni) veličine oko 12 
pt dati dobar rezultat. Najbo-
lje je koristiti crni tekst na 
beloj pozadini; obojeni ili de-
korativni fontovi najteže se 
prepoznaju.
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SAVET 

19  
Pravljenje PDF dokumenta 
pomoću slike sa Clipboarda

Operativni sistem računara koristi prostor za smeštanje podataka 
koji se naziva Clipboard. Sadržaj koji izaberete i kopirate iz doku-
menta, smešta se na Clipboard i potom možete da ga umetnete na 
drugu lokaciju ili u drugi dokument. Dva su načina za korišćenje Clip-
boarda u Acrobatu – pravljenje nove datoteke i dodavanje sadržaja 
Clipboarda postojećoj datoteci.

Pravljenje novog dokumenta
1. U izvornom programu izaberite i kopirajte sliku koju hoćete da 

prenesete u PDF dokument (slika 2.64).

 

Slika 2.64 Izaberite  
i kopirajte sliku koju ćete 
koristiti za novi dokument.

2. U Acrobatu, pritisnite dugme Create PDF i iz menija izaberite 
opciju From Clipboard Image (slika 2.65).

 

Slika 2.65 Pošto ste sliku kopirali 
na Clipboard, izaberite opciju From 
Clipboard Image.
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3. Sadržaj Clipboarda se konvertuje u novu PDF datoteku (slika 
2.66). Snimite datoteku.

Slika 2.66 Slika sa Clipboarda postaje nov PDF dokument.

Dodavanje sadržaja Clipboarda postojećoj datoteci
1. Izaberite i kopirajte sliku koju ćete upotrebiti u postojećem PDF 

dokumentu. Nakon kopiranja slika je smeštena na Clipboard.

2. U Acrobatu izaberite opciju Tools > Advanced Commenting > 
Attach > Paste Clipboard Image (slika 2.67).

Slika 2.67 Sadržaj Clipboarda možete da umetnete u drugi  
PDF dokument.

SAVET 19: Pravljenje PDF dokumenta pomoću slike sa Clipboarda

Šta je na Clipboardu?
Ponekad ćete zaboraviti šta ste 
poslednje kopirali na Clipboard 
i da li to želite ponovo da koristi-
te. Sadržaj Clipboarda možete 
da vidite iz Acrobata 6 izborom 
opcije Window > Clipboard Vie-
wer. Otvoriće se prozor koji pri-
kazuje sadržaj Clipboarda.
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3. Preko stranice pomerajte pokazivač dok ne poprimi oblik 
krstića. Mišem pritisnite mesto na stranici na koje hoćete da 
umetnete sliku (slika 2.68). Mesto na kojem je pokazivač biće 
centar slike.

 

Slika 2.68 Pritisnite mesto 
na stranici na koje hoćete 
da umetnete sliku.

4. Acrobat će umetnuti sliku na stranicu. Pokazivač u obliku 
krstića menja se u alatku Hand (u obliku šake). Pritisnite sliku 
na stranici da biste je izabrali.

5. Prevlačite sliku da biste je pomerili ili povucite ručice za pro-
menu veličine da biste promenili veličinu slike (slika 2.69).

Slika 2.69 Pomerajte umetnutu sliku i menjajte joj veličinu.

6. Snimite datoteku sa umetnutom slikom.
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